Telemetric Physiological Monitoring System

PRODUCT MANUAL
# SharkTooth Manual

## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>SharkTooth Manual</td>
<td>i</td>
</tr>
<tr>
<td>Contents</td>
<td>i</td>
</tr>
</tbody>
</table>

### Installation

- Installing the Software: 1
- Installing the Hardware: 4

### Getting Started

- Launching the Software: 6
- Software Overview: 6
- Receiver Configuration: 8
- Transmitter Configuration: 9

### Collecting Data

- Test Setup: 10
- Commencing Recording: 12
- General Operation: 12
  - SharkTooth Main Window: 12
  - Temperature View: 13
  - ECG View: 14
  - Detail View: 15
  - Terminating Recording: 15

### Playback Mode

- Recalling Saved Data: 16

### Advanced

- Configuration: 17
  - Temperature: 17
  - ECG: 18
  - Export: 18

### Requirements

- Minimum Requirements: 19

### Support

- Troubleshooting: 20
Installation

Installing the Software

The SharkTooth software must be installed onto your PC before it can be used. An installation wizard is supplied on a CD accompanying the product. Alternatively, updates may be downloaded via the internet or emailed from our support team; these are simply launched directly from where you saved them. Before installation, you must ensure your PC meets the minimum requirements and provides the necessary ports (see the ‘Requirements’ section).

Typically, the installation wizard (and any future updates) require administrator privileges to be able to make changes to your system. You may need to consult with your network administrator for assistance in this matter. Note: To avoid any potential conflicts during installation, before launching the installation wizard, it is recommended that you close any applications you are working in. It is also good practice, and highly recommended, to make a complete backup of your system including your critical documents/data/files to guard against any possible damage/loss.

1. To launch the installation wizard, simply insert the supplied SharkTooth CD. After a short delay, the installation wizard should start automatically. In the event it does not, auto-play is disabled on your computer. In which case, you will need to launch the setup manually from the CD-ROM.

2. After some internal preparation, the installation wizard welcomes you and confirms the application to be installed. Click ‘Next’ to proceed with the installation.

   **Important:** On some systems, the Microsoft Installer may need to update critical system components before the installation wizard can proceed. You may be prompted to restart your computer, after which the installation wizard will automatically resume and proceed as normal. In extreme cases multiple restarts may be required.

3. You will be prompted for your customer information. This may appear on any reports you print – please enter it as you would like it to appear.

4. You may select to which users the application is made available to (useful for corporate or institution users).

   Selecting ‘Only for me’ avoids the software being placed in other users’ start menus, but does not prevent them manually launching the software directly. If you are uncertain, you should accept the default selection.
5. Click ‘Next’ to proceed.

Here you may choose where the application should be installed. Most users can simply accept the default location.

Should you wish to install elsewhere, click ‘Change’ to select an alternative location. Note: If installing for ‘All Users’ you must select a location available to every user, bearing in mind their access privileges.

6. Once you are happy with the install location, click ‘Next’ to proceed.

7. You may select the type of installation to be performed and then click ‘Next’ to proceed.

- Complete installation installs the full application with all features, help, manuals & tutorials.

- Custom installation allows you to select exactly which features are to be installed and the individual install location of each component. Note: Custom installation is only recommended for advanced users and is not documented here.

8. The wizard has ascertained all the necessary details to begin installation. This is your final chance to review the summary of the options you have selected.

Click ‘Install’ to begin the physical installation process. Alternatively, if you would like to review/change any of the options use the ‘Back’ button to backtrack through the selection process.
9. The features you selected will now be installed.

Please wait whilst the process completes. This task may take several moments.

10. Once complete, the wizard will inform you as to the success of the operation.

The ‘Launch MIE SharkTooth’ checkbox allows you to automatically launch the application upon exiting the wizard.

Typically you can click ‘Finish’ to exit the installation wizard. Note, however, if some files in need of updating were in use, you may be prompted to restart your computer. These files will then be updated during the restart and the wizard will exit automatically.
Installation

Installing the Hardware

SharkTooth acquires data signals from its multiple wireless transmitters using a specially designed receiver. Your computer operating system requires appropriate drivers be installed to enable it to communicate with the SharkTooth Receiver. Such drivers need only be installed once, when the receiver is connected to your computer for the first time.

Installation of the SharkTooth Receiver is extremely straightforward. The device connects to the USB port of your computer and will automatically be detected by your computer. Upon detection the computer will present you with the ‘Found New Hardware Wizard’ which guides you through the driver installation process. Please follow the simple steps documented below.

1. Ensure that the SharkTooth CD-ROM is inserted into your computer and that you are logged in with administrator privileges.

2. Connect the SharkTooth receiver to a USB port on computer using the supplied USB A-B connecting cable.

After a short moment, the ‘Found New Hardware Wizard’ should be displayed.

Depending on your system settings you may be prompted to connect to Windows Update to search for drivers from Microsoft’s website (otherwise skip to step 3).

The SharkTooth Receiver drivers are not held within Microsoft’s repository so you must skip this search process.

1. Select ‘No, not this time’.
2. Press ‘Next’ to proceed.

The Wizard should now prompt you as pictured opposite.

3. Ensure ‘Install the software automatically’ is selected.

4. Click ‘Next’ to proceed.

The system will now analyse the device and search for appropriate drivers.
After a short delay, the system should identify the device as an ‘MIE SharkTooth Receiver’.

Depending on your system policies, you may receive a warning, stating that the software has not passed Windows Logo testing. Our devices are not submitted to Windows Logo testing. However, you can be assured that they have passed our own strict testing procedures.

5. Assuming you are happy to proceed, click ‘Continue Anyway’.

The system will now copy the necessary drivers and files to your system.

This process may take a few moments.

The hardware driver installation process is now complete and should display confirmation accordingly.

Note: In rare occasions you may be prompted to restart your computer to finalise the installation process.

6. Click ‘Finish’ to close the ‘Found New Hardware Wizard’.

The green STATUS light on the top of the SharkTooth Receiver unit should now be illuminated, confirming the drivers are correctly installed and that the device is ready for use.
Getting Started

Launching the Software

Once installed, the SharkTooth software can be launched from your desktop or start menu.

From your desktop:

1. Locate the ‘SharkTooth’ program icon on your desktop.

2. Double-click on the ‘SharkTooth’ program icon.

N.B. Depending on your settings, it may only be necessary to single-click the icon in order to launch the application.

Alternatively, from your start menu:

1. Click on the Windows 'Start' button.

2. Click on the 'All Programs' folder from the list (or ‘Programs’ folder on older operating systems).

3. Click on the 'MIE Medical Research Ltd' folder.
   N.B. Depending on your system settings, this entry may appear at the foot of the list rather than in alphabetical order.

4. Click on the 'SharkTooth' folder.

5. Click on the 'SharkTooth' program icon.

💡 Tip: In Windows, you may choose to sort the programs list by right clicking on an entry and choosing ‘Sort By Name’. Alternatively, you may place the entry anywhere in the list by dragging the entry to your preferred position.
Getting Started

Software Overview

Upon loading the SharkTooth software you will be presented with several windows. The purpose of each window will be explained briefly here to aid you in working through this manual.

Pictured below are the various windows of the SharkTooth software (clockwise from top-left: Temperature View, SharkTooth Main Window, Detail View and ECG View)

**SharkTooth Main Window:**
Overall control panel for the software.

**Temperature View:**
Displays real-time thermistor values from each channel (columns) of each transmitter/subject (rows).

**ECG View:**
Shows real-time ECG and heart rate from each transmitter/subject (rows).

**Detail View:**
Displays signals or trends of interest. Up to three signals or trends can be displayed simultaneously. As none have been selected yet the product logo is displayed as pictured.

The software is designed for use on computers with dual or triple head support (i.e. those with two or three displays) but can also be used on a conventional single display system. Multiple displays allow for each view window to have its own dedicated display - providing greater clarity to the user.

The window positions and layout are automatically saved each time you close the software so your preference is retained. SharkTooth can also automatically organise the windows in a ‘best-fit’ mode by selecting the appropriate number of displays from the ‘Window’ menu of the SharkTooth Main Window. You may want to do this now so that you have the optimum layout for your configuration.
Getting Started

Receiver Configuration

Having installed the software and drivers for the receiver we must now configure the receiver for use. This need only be done when setting up the SharkTooth system for the first time.

1. Launch the software as outlined previously.
2. Choose ‘Bluetooth…’ from the ‘Data’ menu of the SharkTooth Main Window.

The Bluetooth Settings window will open. The ‘General’ tab is the area of interest to us and should be displayed as pictured opposite.

The ‘Auto Connect Transmitters’ option forces the system to connect to each transmitter immediately upon launching the software. This is handy if you perform repeated experiments using identical transmitter configurations. However, for most users we recommend you leave this setting disabled.

The ‘Auto Acquire Data’ ensures that once a transmitter is connected to the system it is immediately (and continuously) polled for its real-time readings. This saves the need to manually start acquiring data each time after connection. It is recommended you enable this setting. Note that this feature does not automatically commence data recording – think of it as a live preview.

The ‘Repeat Connect’ and ‘Read RSSI’ settings are advanced settings and should not be changed. In the event you change them inadvertently, use the ‘Reset to Defaults’ button to restore the defaults.

The ‘Port Status’ at the top of the form should read ‘Ftdi USB Port: Available’. If so, the receiver has automatically been detected and you can skip to step 7. Otherwise follow the simple steps below:

3. Click ‘Configure Port…’

The Communication Port Setting Window should be displayed.

4. Ensure that ‘Ftdi USB device’ is selected rather than ‘Com Port Device’.
5. Click ‘Start’ to search for the SharkTooth receiver. The ‘Ftdi Port’ message should read ‘Ftdi USB Port: Available’. In the event it does not, disconnect and reconnect the receiver unit and try again. If the problem persists, it is likely the drivers were not correctly installed. Be prepared to note any message here and call support for assistance.
6. Click ‘Close’ to return to the previous form.

7. Click ‘Save’ to apply any changes you have made.

Normally, you would now close the window. However, in the next section of this document you will be asked to re-open it – so feel free to leave it open and skip the first two steps in the next section.
Getting Started

Transmitter Configuration

Getting Started

When setting up the SharkTooth system for the first time it is necessary to identify each transmitter that will be used with the system. Each transmitter has a unique address, referred to as a BDA address, which must be entered into the software before use. You should only ever need to do this once unless a transmitter is lost/damaged/faulty and you have to obtain a replacement.

1. Launch the software as outlined previously.
2. Choose ‘Bluetooth…’ from the ‘Data’ menu of the SharkTooth Main Window. The Bluetooth Settings window will now be displayed.
3. Click the ‘Transmitter Config’ tab along the top of the page. The transmitter BDA address configuration will now be displayed.

A SharkTooth system typically comprises of up to 6 transmitters. However, if required up to two systems can be operated simultaneously in the same geographical location (providing monitoring for up to 12 subjects). For maximum versatility the two systems can also be used independently providing two 6 six subject systems at differing geographical locations. Consequently, to avoid confusion, each transmitter is colour coded according to which system it belongs. So, for example, you may have 6 transmitters with blue labels and 6 transmitters with green labels.

Alongside the BDA address, you must assign each transmitter an ID of your choosing to help you identify it later. We recommend using first letter of transmitter label colour, followed by the transmitter number. E.g. ‘B01’ for Blue Transmitter No 1, ‘G03’ for Green Transmitter No 3, etc.

SharkTooth transmitters are also available in waterproof models (again coloured differently). We suggest identifying these with the prefix ‘W’. I.e. ‘W01’ for Waterproof Transmitter No 1, etc.

It is probably worth noting at this stage that the system does not distinguish between a blue transmitter and that of a green one any more than it does between a water-proof model and a non water-proof model. The colour coding of transmitters is purely to aid you - they can all be interchanged as you wish – up to a maximum of any 6 transmitters per system.

4. Enter the transmitter BDA address and ID of your choosing for each transmitter in your possession (up to a maximum of 15). Each transmitter is numbered and colour coded on its front. The BDA addresses can be found printed on the rear of each transmitter.
5. Enable the transmitters you intend to use with this system for data collection (up to 6 max).
6. Click ‘Save’ and ‘Apply’ before closing the form.

Your SharkTooth Transmitters are now configured and ready for use.
Collecting Data

Test Setup

Having configured the system for use, collecting data from the transmitters is straightforward.

1. Click ‘Setup’ on the SharkTooth Main Window to display the setup wizard which will prepare the system for data collection.

The transmitters you enabled previously will each be listed on the ‘Channels’ tab of the setup wizard.

2. Enter a subject identification of your choice alongside each transmitter ID. For example, you may wish to enter the subject’s initials or surname. This information will be displayed alongside any acquired data and will aid in you determining which data relates to which subject.

3. Click ‘Next’ to proceed to the ‘Duration’ tab.

Here you can specify a duration for the test recording. If you select ‘Stop test automatically’ data recording will automatically be terminated after the duration has elapsed. Alternatively, leave the duration at zero if you prefer to terminate data recording manually.

4. Click ‘Next’ to proceed to the ‘Transmitters’ tab.
5. Click ‘Connect Transmitters’ to establish communication with the transmitters you enabled earlier.

The system will hunt for each transmitter repeatedly until it is found. The status of each enabled transmitter is indicated by the row of virtual LEDs (coloured circles) in the centre of the form. These can be coloured as follows:

- Transmitter switched off or not yet connected
- Connected, awaiting synchronisation
- Connected and synchronised - ready for data acquisition
- Data acquisition in process – receiving data

At the moment, the status of each transmitter should be red (switched off or not yet connected) and it is likely connection errors will be displayed. This is because we have not yet switched on the transmitters - so the software is unable to connect to them.

6. Switch on each of the transmitters that you enabled in the software earlier.

Non water-proof models are switched on using a small blunt object to momentarily press the recessed switch in the side of the transmitter case. Water-proof models are switched on using a special magnetic keyfob (supplied with each transmitter) – simply touch the end of the keyfob to the KEYFOB labelled area on the transmitter.
You can switch on the transmitters in any order you like – the software will cycle through, trying to connect to each one in turn until they are all connected. A blue LED will be illuminated on each transmitter to indicate that it is switched on. This LED will begin to flash once the software has connected to it. You should see corresponding status information in the software as each transmitter is connected and automatically synchronised.

Please note that the transmitters will automatically time out and switch off (to conserve power) if a connection is not established within 10 minutes. This may be frustrating if you have subjects in the field, or in water, which power down through inactivity. For this reason, it is recommended you avoid switching on the transmitters until after you have requested the software to initialise connection – this maintains activity ensuring the transmitters remain switched on.

Note also that whilst the software can switch off a transmitter remotely, it cannot switch it on. This must always be done manually.

Once connected, the battery power of each transmitter will be displayed above its status LED. This allows you to quickly check each transmitter has sufficient power to complete your test duration. If you need to change which transmitters will be used, you can use the ‘Transmitter Config…’ button – though you will need to return to the ‘Channels’ page to re-enter the corresponding subject info and repeat the connection process to connect to the new transmitter configuration.

Each of your transmitters should now be connected and synchronised (as pictured above). If not, it is likely the transmitter is not switched on, is out of range, is not enabled in the transmitter config or its BDA address has been entered incorrectly.

Once all the transmitters you selected have connected, you are ready to proceed.

7. Click ‘Acquire Data’ to commence data acquisition. Note that if the software has been configured to ‘auto acquire data’ you can skip this step, as it will have been done automatically.

Note that data acquisition is not the same as data recording. Data acquisition means that real-time readings will be taken from each transmitter and displayed on screen but are not saved (a preview mode if you like). Data recording, on the other hand, means that the data will be stored to disk so that it can be retrieved at a later date. Activating data recording will be explained shortly.

8. Click ‘Finish’ to close the setup wizard.

The test session is now configured and you are ready to begin recording data (assuming your subjects are ready!).
Collecting Data

Commencing Recording

You should now see the live ECG and temperature readings from each of your subjects being displayed. You should take this opportunity to verify that the ECG electrodes on each subject are positioned correctly and providing a good signal, free from artefacts during movement. You should also verify that each temperature thermistor is functioning correctly.

9. When you are ready to begin data recording click ‘Start Test’ in the SharkTooth Main Window.

The test time will now begin counting from 0:00:00.

The data recording will continue until the specified test duration elapses or you terminate data collection manually by clicking ‘Stop’.

General Operation

Here, we’ll explore each window and the program’s operation in more detail.

SharkTooth Main Window

The SharkTooth Main Window continues to provide us with overall control for the test session.

At the foot of the window, the status of each transmitter is provided (as explained previously) – this may be important if a transmitter goes out of range for an extended period for example.

We can use the ‘Event Log’ button to make a note of any important events which occur during our test. The time when the button is pressed is automatically recorded in the log. Events can be assigned to a single subject/transmitter or noted as common to all.

Feel free to record an event now, so you can understand how the feature works.

The ‘ECG Record’ and ‘Export’ buttons will be explained later.
**Temperature View**

The *Temperature View* provides us with the 7 thermistor readings for each subject (T1 to T7) along with 3 user-definable calculated readings (C1 to C3).

The calculated readings allow you to provide results using simple equations to derive figures from the other sensor values. For example, you could define a calculated reading to provide the mean average value of two thermistor values. Or, perhaps you prefer to know the peak value of all the thermistor values for a given subject. Other users may prefer to calculate a value according to various weights they associate with each sensor. The possibilities are quite varied – information on defining the calculated value formulas will be discussed later in this document under the configuration section.

You will note that the colour of each reading may be different – this is dependant upon its current value in relation to user definable thresholds. Values falling within or above or below a given threshold are coloured differently.

A total of four thresholds (two upper and two lower) can be configured for each temperature sensor or calculated value. Upon rising above an upper threshold or falling below a lower threshold, an alarm condition is triggered. Upon passing the first threshold, the value is coloured *light red* (upper) or *light blue* (lower) to alert you that your attention may be required. Upon passing the second threshold, the value is coloured *pure red* or *pure blue* and audible alarm is sounded to draw your attention more urgently. This alarm condition will continue until the value returns within the defined threshold levels.

The threshold levels can be configured on a per channel basis but are common between all subjects. To configure the thresholds for a given channel, click on the threshold values displayed at the top of the desired column.

By choosing your threshold values carefully you can ensure that your attention is drawn when a subject’s temperature thermistor begins approaching a level you might consider undesirable or requires intervention (*Hi1* or *Lo1*). The second threshold (*Hi2* or *Lo2*) can be configured to ensure your attention is more forcibly drawn if a more serious value is reached. Naturally, you can configure both threshold levels to be the same value if you do not want the intermediate warning level. Similarly, you can configure extreme threshold values if you prefer the alarm activations did not occur.

Clicking on a given temperature value allows you to view the trend for that thermistor (up to the last 40 minutes). The trend will automatically be graphed at the foot of the *Detail View*.
**ECG View**

The ECG View provides us with the real-time ECG signal of each subject along with their current heart rate (averaged over the last few beats).

The heart rate values are displayed in a similar manner to that of the temperature values discussed previously, in that they are coloured according to their level in relation to user definable thresholds. As with the temperature thresholds it is possible to define four threshold levels – the behaviour of which is identical to that discussed previously. The only difference is that the threshold values can be defined individually for each subject/transmitter rather than being common to them all.

To configure the heart rate threshold values simply click on the threshold values displayed immediately below the heart rate value of the subject you wish to configure.

Clicking on a given heart rate value allows you to view the trend for that subject’s heart rate (up to the last 40 minutes). The trend will automatically be graphed at the foot of the Detail View.

Clicking on a given ECG trace allows you to view that subject’s ECG trace in more detail. The selected ECG will automatically be graphed at the foot of the Detail View.

In the event you see something of interest or concern in the live ECG trace, the software incorporates a mini ECG recording strip facility complete with the ability to roll-back in time. Pressing the spacebar or clicking ‘ECG Record’ in the SharkTooth Main Window activates this facility and performs a mini ECG recording. It causes the software to roll-back and recall the previous few seconds (20 seconds by default) of ECG recording, before you activated the facility. It then continues to capture the ECG for an additional number of seconds (a further 40 by default) so you can determine if the ECG event is repeated. The ECG of all subjects is captured by this facility. During the capture of this mini ECG recording, a yellow circle will be displayed in the upper left of each ECG trace to show the facility is active. When complete, the software will display the mini ECG recording strip (showing both before and after you activated the facility).

The mini-ECG recording strip will remain on screen for 15 seconds and then be closed automatically. If you wish to retain the mini ECG recording on screen for longer, simply click on the ‘Break’ button at the foot of the window before the 15 seconds elapses.

You can use the time jump navigation buttons at the foot of the form to step through the mini ECG recording.
Collecting Data

Detail View

Finally, the Detail View allows us to view specific signals or trends in more detail.

As we have already seen, simply clicking on the data of interest in the other windows will cause it to be displayed in the bottom third of the Detail View.

Up to three signals or trends can be displayed in this window at any one time. The previous selections are simply shifted up the window each time a new selection is made.

Pictured opposite is the detailed view of an ECG signal, a temperature trend (T2) and a heart rate trend – all from different subjects.

If necessary, you can re-order the Detail View by dragging the top, middle or bottom section to its desired position. Alternatively, simply re-click on the signals or trends you require in the other windows, in the order you would prefer them to be displayed.

Terminating Recording

10. When your recording is complete, click the ‘Stop’ button of the SharkTooth Main Window to terminate data recording. The acquired data from the test session will now be saved to your computer.

Note that live data acquisition will still continue but the data will no longer be recorded.

If you are finished with the transmitters and do not intend to take any further recordings, click the ‘Power Off’ button on the SharkTooth Main Window. This will terminate data acquisition completely and power down each transmitter.

If desired, you can use the ‘Export’ button to export the minute averaged trends from the recorded data to an ASCII delimited text file. This can be subsequently imported into third-party applications like Microsoft Excel for further analysis. It is also possible to export the complete raw data in ASCII format using the Data menu if desired.

If you wish to review the data you have just recorded – SharkTooth contains a playback mode which allows you to review the data as if it were being captured live. Simply click the ‘Playback Mode’ tab on the SharkTooth Main Window and click ‘Play’. The playback mode is documented in more detail in the next section of this document.
Playback Mode

Recalling Saved Data

Once saved, data can be loaded and recalled at any time. The data is played back as if it were being acquired live. To playback a file:

1. Select ‘Load Data…’ from the ‘Data’ menu of the SharkTooth Main Window.
2. Select the file of interest and choose ‘Open’.

The files are named according to the date and time the recording was made (in the format YYYYMMDD_HHMMSS).

3. Click ‘Play’ to commence data playback.

Feel free to pause the playback at any time using the ‘Pause’ button.

When paused, you can use the time jump navigation buttons, or scroll bar, to skip forwards and backwards through time in the recorded data. You can also double-click on events in the ‘Event Log’ to jump to the time index when the event occurred. Simply click ‘Play’ again to resume playback from the chosen time index.

The operation of the other windows functions in exactly the same manner as during data collection. So, you are still able to review signals in detail along with the trends of a particular channel at any given time.
Advanced Configuration

The software provides a number of settings which can be customised using the ‘Settings’ menu from the SharkTooth Main Window. Choose the menu option appropriate to the settings you wish to configure and refer to the corresponding section below.

Temperature

Here you can define the formulas which are used to render the temperature values displayed under the C1, C2 and C3 columns of the Temperature View during acquisition.

The formulas allow you to make calculations based upon thermistor readings from other channels on the transmitter (T1-T7). You can also use basic mathematical functions in your formula such as sine, logarithm, etc.

The list of functions and variables you can use are listed in the upper left of the form. The upper right of the form outlines the syntax and rules which your formula must obey.

To define a formula, simply enter in the appropriate row at the foot of the page.

The ‘Variable’ T1-T7 fields allow you to define test values for use in your formula – so you can ensure it is working correctly. During acquisition these values will be replaced with the live thermistor readings for that channel.

You can test each formula using the appropriate ‘Parser’ button to the right of each row. The answer (based upon your test values) will be displayed. In the event your formula contains an error this too will be displayed.

Once you are happy with the formulas you have defined click ‘Use & Save Expressions’ to store your changes.

In the example picture above:

- \( C1=\frac{(T1+T2+T3)}{3.0} \) Calculates the mean average of T1, T2 and T3.
- \( C2=\text{Max}(T2, T3) \) Calculates the peak value of T2 and T3.
- \( C3=\text{Min}(T4, \text{Min}(T5, \text{Min}(T6, T7))) \) Calculates the minimum value of T1, T2, T3 and T4.
ECG

The *ECG Setting Window* allows you to configure how the ECG signal is processed and displayed.

Enabling ‘RR mark’ means that the software will identify each heart beat it detects in the ECG trace. This will be indicated in the *ECG View* as a vertical yellow line. Generally, this feature is not required for most users.

The ‘Sound Alarm’ controls whether audible alarms will be sounded for subject heart rates exceeding the user-defined thresholds. Silencing alarms in this manner should be done with caution as other users of the system may not be aware of your configuration change.

The ‘Strip [s]’ parameters allow you to configure the duration of any mini ECG recording strips. The first value determines the rollback duration (before the facility was activated), whilst the second value determines the duration to record afterwards.

The ‘ECG grid’ and ‘Horizontal [ms]’ parameters allow you to customise the background lines and display speed of the ECG signal being rendered.

Export

The *Export Settings Window* allows you to control exported data.

You can specify the default location where data should be exported.

You can also define the behaviour of the ‘Export’ button on the *SharkTooth Main Window*. Choosing whether it exports trends averaged over each minute of the test or the dataset in its entirety. Unchecking ‘Use subject data’ allows you to anonimise exported data in order to protect subject confidentiality (subject identification will be excluded from the exported data).
Requirements

Minimum Requirements

The SharkTooth software has been designed for use on a modern high-end PC. Units with cut-down processors without onboard cache or floating point units should be avoided due to the mathematical dependency of the software.

Placing PC specifications here is somewhat fruitless due to the speed at which the technology is evolving. SharkTooth will be continuously updated and enhanced throughout its life cycle and its requirements will evolve accordingly.

However, the following minimum requirements are absolute:

- 1 free Universal Serial Bus port (USB port)
- Compatible operating system (see table below) with Internet Explorer V5.5+
- 1GB free hard disk space for installation - additional space required for recorded data
- 512MB memory
- 1024x768 graphical output display and compatible monitor
- CD-ROM (or networked CD-ROM) for installation

Recommended:

- Dual or triple-head display capable graphics card with 2 or 3 displays - each 1024x768.
- External storage for data backup (CD/DVD writer / maintained network / flash stick / etc)
- Internet connection for obtaining latest updates

It is also highly recommended that as large a display screen as possible is used as it is easier to see the multiple graphs that can be produced and displayed with SharkTooth. Most users prefer using two or even three 17” monitors for quick analysis.

The SharkTooth software has been designed to work on the Windows® operating system and is compatible with the versions listed opposite. Earlier versions of Windows® are not supported. Support for future versions of Windows® will be implemented subject to availability, feasibility and demand (upgrades to future releases may be charged).
If you are experiencing any problems whilst using or installing the SharkTooth software please feel free to contact our support team. However, before doing so, it is worth performing a couple of quick checks to ensure the problem is not already documented and has not already been resolved. This saves unnecessary support calls and minimises the delay and inconvenience to you.

Any last minute problems found at time of shipping may be appended to the rear of this section or to the rear of the manual. These appendices, referred to as knowledge base articles, often contain fixes or workarounds for the documented problem. You will also find a more up-to-date collection of our knowledge base articles on our website: http://www.mie-uk.com/support/SharkTooth/

Secondly, any release notes displayed during installation may outline any known problems with your release.

Finally, it is always worth downloading and installing the latest update of the software from our website. Here you will also find updated release notes which may also document your problem.

Visit http://www.mie-uk.com/software/SharkTooth to obtain the latest version.

Assuming your problem persists or you have some feedback you would like to offer, please don’t hesitate to contact our support team.

Email: Support@mie-uk.com
Tel: +44 (0)113 279 3710
Fax: +44 (0)113 231 0820

Before contacting us, it would be advantageous if you could prepare a detailed description of the problem you are experiencing and the steps necessary to reproduce it if at all possible.